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Preface

This manual describes Campus Manager 4.0.3 and provides instructions for 
installing and configuring it.

Audience
This document is for anyone who installs, configures, verifies, and uses 
Campus Manager 4.0.3 software. Network administrators or operators should 
have the following skills:

• Basic Solaris system administrator skills

• Basic network management skills

• Basic Internet browser skills

Conventions
This document uses the following conventions:

Item Convention

Commands and keywords boldface font

Variables for which you supply values italic font

Displayed session and system information screen font
vii
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Preface
Product Documentation
Note Means reader take note. Notes contain helpful suggestions or references to 
material not covered in the publication. 

Caution Means reader be careful. In this situation, you might do something that could 
result in equipment damage or loss of data.

Product Documentation

Note We sometimes update the printed and electronic documentation after original 
publication. Therefore, you should also review the documentation on Cisco.com 
for any updates.

Information you enter boldface screen font

Variables you enter italic screen font

Menu items and button names boldface font

Selecting a menu item in paragraphs Option > Network Preferences

Selecting a menu item in tables Option > Network Preferences

Item Convention
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Preface
Product Documentation
Table 1 describes the product documentation that is available.

Table 1 Product Documentation

Document Title Available Formats

Release Notes for Campus 
Manager 4.0.3 on Solaris

• Printed document that was included with the product.

• PDF on the product CD-ROM

• On Cisco.com at this URL:
http://cisco.com/en/US/products/sw/cscowork/ps563/
prod_release_notes_list.html

Release Notes for Campus 
Manager 4.0.3 on Windows

• Printed document that was included with the product.

• PDF on the product CD-ROM

• On Cisco.com at this URL:
http://cisco.com/en/US/products/sw/cscowork/ps563/
prod_release_notes_list.html

Installation and Setup Guide for 
Campus Manager 4.0.3 on Solaris

• Printed document that was included with the product.

• PDF on the product CD-ROM.

• On Cisco.com at this URL:
http://cisco.com/en/US/products/sw/cscowork/ps563/
prod_installation_guides_list.html

• Printed document available by order (part number 
DOC-7817187=).1

Installation and Setup Guide for 
Campus Manager 4.0.3 on 
Windows

• Printed document that was included with the product.

• PDF on the product CD-ROM.

• On Cisco.com at this URL:
http://cisco.com/en/US/products/sw/cscowork/ps563/
prod_installation_guides_list.html

• Printed document available by order (part number 
DOC-7817188=).1
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Preface
Related Documentation
Related Documentation

Note We sometimes update the printed and electronic documentation after original 
publication. Therefore, you should also review the documentation on Cisco.com 
for any updates.

User Guide for Campus 
Manager 4.0.3

• PDF on the product CD-ROM.

• On Cisco.com at this URL:
http://cisco.com/en/US/products/sw/cscowork/ps563/
products_user_guide_list.html

• Printed document available by order (part number 
DOC-7817186=).1

Supported Devices Table for 
Campus Manager 4.0.3

On Cisco.com at this URL:
http://cisco.com/en/US/products/sw/cscowork/ps563/
products_device_support_tables_list.html

Context-sensitive online help • Select an option from the navigation tree, then click Help.

• Click the Help button in the dialog box.

1. See the “Obtaining Documentation” section on page xii.

Table 1 Product Documentation (continued)

Document Title Available Formats
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Preface
Related Documentation
Table 2 describes the additional documentation that is available.

Table 2 Related Documentation

Document Title Available Formats

Release Notes for CiscoWorks 
Common Services 3.0.3 (Includes 
CiscoView 6.1.2) on Solaris

• Printed document that was included with the product.

• PDF on the product CD-ROM.

• On Cisco.com at this URL:
http://cisco.com/en/US/products/sw/cscowork/ps3996/
prod_release_notes_list.html

Release Notes for CiscoWorks 
Common Services 3.0.3 (Includes 
CiscoView 6.1.2) on Windows

• Printed document that was included with the product.

• PDF on the product CD-ROM.

• On Cisco.com at this URL:
http://cisco.com/en/US/products/sw/cscowork/ps3996/
prod_release_notes_list.html

Installation and Setup Guide for 
CiscoWorks 
Common Services 3.0.3 (Includes 
CiscoView 6.1.2) on Solaris

• Printed document that was included with the product.

• PDF on the product CD-ROM.

• On Cisco.com at this URL:
http://cisco.com/en/US/products/sw/cscowork/ps3996/
prod_installation_guides_list.html

• Printed document available by order (part number 
DOC-7817183=).
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Additional Information Online
Additional Information Online
Service Packs (SP) contain updated files necessary for the latest device support 
and fixes to known problems that are not available in Campus Manager. If you are 
a registered user, you can download the Service Packs for Campus Manager from:

http://www.cisco.com/cgi-bin/tablebuild.pl/cw2000-campus

Obtaining Documentation
Cisco documentation and additional literature are available on Cisco.com. Cisco 
also provides several ways to obtain technical assistance and other technical 
resources. These sections explain how to obtain technical information from Cisco 
Systems.

Installation and Setup Guide for 
CiscoWorks 
Common Services 3.0.3 (Includes 
CiscoView 6.1.2) on Windows

• Printed document that was included with the product.

• PDF on the product CD-ROM.

• On Cisco.com at this URL:
http://cisco.com/en/US/products/sw/cscowork/ps3996/
prod_installation_guides_list.html

• Printed document available by order (part number 
DOC-7817184=).

User Guide for CiscoWorks 
Common Services 3.0.3

• PDF on the product CD-ROM.

• On Cisco.com at this URL:
http://cisco.com/en/US/products/sw/cscowork/ps3996/
products_user_guide_list.html

• Printed document available by order (part number 
DOC-7817182=).

Table 2 Related Documentation (continued)

Document Title Available Formats
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Obtaining Documentation
Cisco.com
You can access the most current Cisco documentation at this URL:

http://www.cisco.com/techsupport

You can access the Cisco website at this URL:

http://www.cisco.com

You can access international Cisco websites at this URL:

http://www.cisco.com/public/countries_languages.shtml

Product Documentation DVD
Cisco documentation and additional literature are available in the Product 
Documentation DVD package, which may have shipped with your product. The 
Product Documentation DVD is updated regularly and may be more current than 
printed documentation.

The Product Documentation DVD is a comprehensive library of technical product 
documentation on portable media. The DVD enables you to access multiple 
versions of hardware and software installation, configuration, and command 
guides for Cisco products and to view technical documentation in HTML. With 
the DVD, you have access to the same documentation that is found on the Cisco 
website without being connected to the Internet. Certain products also have .pdf 
versions of the documentation available.

The Product Documentation DVD is available as a single unit or as a subscription. 
Registered Cisco.com users (Cisco direct customers) can order a Product 
Documentation DVD (product number DOC-DOCDVD=) from Cisco 
Marketplace at this URL:

http://www.cisco.com/go/marketplace/
xiii
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Documentation Feedback
Ordering Documentation
Beginning June 30, 2005, registered Cisco.com users may order Cisco 
documentation at the Product Documentation Store in the Cisco Marketplace at 
this URL:

http://www.cisco.com/go/marketplace/

Nonregistered Cisco.com users can order technical documentation from 8:00 a.m. 
to 5:00 p.m. (0800 to 1700) PDT by calling 1 866 463-3487 in the United States 
and Canada, or elsewhere by calling 011 408 519-5055. You can also order 
documentation by e-mail at tech-doc-store-mkpl@external.cisco.com or by fax at 
1 408 519-5001 in the United States and Canada, or elsewhere at 011 408 
519-5001.

Documentation Feedback
You can rate and provide feedback about Cisco technical documents by 
completing the online feedback form that appears with the technical documents 
on Cisco.com.

You can send comments about Cisco documentation to bug-doc@cisco.com.

You can submit comments by using the response card (if present) behind the front 
cover of your document or by writing to the following address:

Cisco Systems
Attn: Customer Document Ordering
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.
xiv
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Preface
Cisco Product Security Overview
Cisco Product Security Overview
Cisco provides a free online Security Vulnerability Policy portal at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.ht
ml

From this site, you can perform these tasks:

• Report security vulnerabilities in Cisco products.

• Obtain assistance with security incidents that involve Cisco products.

• Register to receive security information from Cisco.

A current list of security advisories and notices for Cisco products is available at 
this URL:

http://www.cisco.com/go/psirt

If you prefer to see advisories and notices as they are updated in real time, you 
can access a Product Security Incident Response Team Really Simple Syndication 
(PSIRT RSS) feed from this URL:

http://www.cisco.com/en/US/products/products_psirt_rss_feed.html

Reporting Security Problems in Cisco Products
Cisco is committed to delivering secure products. We test our products internally 
before we release them, and we strive to correct all vulnerabilities quickly. If you 
think that you might have identified a vulnerability in a Cisco product, contact 
PSIRT:

• Emergencies— security-alert@cisco.com

An emergency is either a condition in which a system is under active attack 
or a condition for which a severe and urgent security vulnerability should be 
reported. All other conditions are considered nonemergencies.

• Nonemergencies— psirt@cisco.com

In an emergency, you can also reach PSIRT by telephone:

• 1 877 228-7302

• 1 408 525-6532
xv
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Obtaining Technical Assistance
Tip We encourage you to use Pretty Good Privacy (PGP) or a compatible product to 
encrypt any sensitive information that you send to Cisco. PSIRT can work from 
encrypted information that is compatible with PGP versions 2.x through 8.x. 

Never use a revoked or an expired encryption key. The correct public key to use 
in your correspondence with PSIRT is the one linked in the Contact Summary 
section of the Security Vulnerability Policy page at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.ht
ml

The link on this page has the current PGP key ID in use.

Obtaining Technical Assistance
Cisco Technical Support provides 24-hour-a-day award-winning technical 
assistance. The Cisco Technical Support & Documentation website on Cisco.com 
features extensive online support resources. In addition, if you have a valid Cisco 
service contract, Cisco Technical Assistance Center (TAC) engineers provide 
telephone support. If you do not have a valid Cisco service contract, contact your 
reseller.

Cisco Technical Support & Documentation Website
The Cisco Technical Support & Documentation website provides online 
documents and tools for troubleshooting and resolving technical issues with Cisco 
products and technologies. The website is available 24 hours a day, at this URL:

http://www.cisco.com/techsupport

Access to all tools on the Cisco Technical Support & Documentation website 
requires a Cisco.com user ID and password. If you have a valid service contract 
but do not have a user ID or password, you can register at this URL:

http://tools.cisco.com/RPF/register/register.do
xvi
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Obtaining Technical Assistance
Note Use the Cisco Product Identification (CPI) tool to locate your product serial 
number before submitting a web or phone request for service. You can access the 
CPI tool from the Cisco Technical Support & Documentation website by clicking 
the Tools & Resources link under Documentation & Tools. Choose Cisco 
Product Identification Tool from the Alphabetical Index drop-down list, or click 
the Cisco Product Identification Tool link under Alerts & RMAs. The CPI tool 
offers three search options: by product ID or model name; by tree view; or for 
certain products, by copying and pasting show command output. Search results 
show an illustration of your product with the serial number label location 
highlighted. Locate the serial number label on your product and record the 
information before placing a service call.

Submitting a Service Request
Using the online TAC Service Request Tool is the fastest way to open S3 and S4 
service requests. (S3 and S4 service requests are those in which your network is 
minimally impaired or for which you require product information.) After you 
describe your situation, the TAC Service Request Tool provides recommended 
solutions. If your issue is not resolved using the recommended resources, your 
service request is assigned to a Cisco engineer. The TAC Service Request Tool is 
located at this URL:

http://www.cisco.com/techsupport/servicerequest

For S1 or S2 service requests or if you do not have Internet access, contact the 
Cisco TAC by telephone. (S1 or S2 service requests are those in which your 
production network is down or severely degraded.) Cisco engineers are assigned 
immediately to S1 and S2 service requests to help keep your business operations 
running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227)
EMEA: +32 2 704 55 55
USA: 1 800 553-2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts
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Obtaining Additional Publications and Information
Definitions of Service Request Severity
To ensure that all service requests are reported in a standard format, Cisco has 
established severity definitions.

Severity 1 (S1)—Your network is “down,” or there is a critical impact to your 
business operations. You and Cisco will commit all necessary resources around 
the clock to resolve the situation. 

Severity 2 (S2)—Operation of an existing network is severely degraded, or 
significant aspects of your business operation are negatively affected by 
inadequate performance of Cisco products. You and Cisco will commit full-time 
resources during normal business hours to resolve the situation.

Severity 3 (S3)—Operational performance of your network is impaired, but most 
business operations remain functional. You and Cisco will commit resources 
during normal business hours to restore service to satisfactory levels.

Severity 4 (S4)—You require information or assistance with Cisco product 
capabilities, installation, or configuration. There is little or no effect on your 
business operations.

Obtaining Additional Publications and Information
Information about Cisco products, technologies, and network solutions is 
available from various online and printed sources.

• Cisco Marketplace provides a variety of Cisco books, reference guides, 
documentation, and logo merchandise. Visit Cisco Marketplace, the company 
store, at this URL:

http://www.cisco.com/go/marketplace/

• Cisco Press publishes a wide range of general networking, training and 
certification titles. Both new and experienced users will benefit from these 
publications. For current Cisco Press titles and other information, go to Cisco 
Press at this URL:

http://www.ciscopress.com
xviii
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Obtaining Additional Publications and Information
• Packet magazine is the Cisco Systems technical user magazine for 
maximizing Internet and networking investments. Each quarter, Packet 
delivers coverage of the latest industry trends, technology breakthroughs, and 
Cisco products and solutions, as well as network deployment and 
troubleshooting tips, configuration examples, customer case studies, 
certification and training information, and links to scores of in-depth online 
resources. You can access Packet magazine at this URL:

http://www.cisco.com/packet

• iQ Magazine is the quarterly publication from Cisco Systems designed to 
help growing companies learn how they can use technology to increase 
revenue, streamline their business, and expand services. The publication 
identifies the challenges facing these companies and the technologies to help 
solve them, using real-world case studies and business strategies to help 
readers make sound technology investment decisions. You can access iQ 
Magazine at this URL:

http://www.cisco.com/go/iqmagazine

or view the digital edition at this URL:

http://ciscoiq.texterity.com/ciscoiq/sample/

• Internet Protocol Journal is a quarterly journal published by Cisco Systems 
for engineering professionals involved in designing, developing, and 
operating public and private internets and intranets. You can access the 
Internet Protocol Journal at this URL:

http://www.cisco.com/ipj

• Networking products offered by Cisco Systems, as well as customer support 
services, can be obtained at this URL:

http://www.cisco.com/en/US/products/index.html

• Networking Professionals Connection is an interactive website for 
networking professionals to share questions, suggestions, and information 
about networking products and technologies with Cisco experts and other 
networking professionals. Join a discussion at this URL:

http://www.cisco.com/discuss/networking

• World-class networking training is available from Cisco. You can view 
current offerings at this URL:

http://www.cisco.com/en/US/learning/index.html
xix
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C H A P T E R 1

Prerequisites

This chapter describes the factors that you should consider before installing 
Campus Manager 4.0.3 on a Solaris system.

This chapter contains:

• Product Overview

• Campus Manager Upgrade Paths

• Server Requirements

• Client Requirements

• Supported Devices
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Product Overview
Campus Manager, a member of the CiscoWorks family of products, is a suite of 
web-based network management tools that enable administrators to obtain various 
types of graphical views of their network topology and end-user information. 
Campus Manager is based on a client-server architecture that connects multiple 
web-based clients to a server on the network. 

Campus Manager server discovers information about network devices and saves 
it in the Campus Manager database so that the applications can access it. For more 
information, see User Guide for Campus Manager 4.0.3.

The Campus Manager applications and what they allow you to do are as follows:

• Path Analysis—View the path that packets take between end nodes/devices 
on your network. 

• User Tracking—Locate and display data about users, IP Phones, hosts, and 
wireless clients in your network. 

• Topology Services—Discover, view, and monitor the physical and logical 
services on your network. View detailed network information about all 
devices, links, and ports in your network. 

• VLAN Port Assignment—View port information, create trunk, configure 
VLANs on a trunk, and move ports between VLANs on your network. 

• Discrepancy Reports—Discover and view physical and logical discrepancies 
in your network. 
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Campus Manager Upgrade Paths
You can upgrade to Campus Manager 4.0.3 from:

• Campus Manager 3.2.x

• Campus Manager 3.3.x

• Campus Manager 4.0

• Campus Manager 4.0 Service Pack 1

• Campus Manager 4.0 Service Pack 2

where .x refers to the IDU upgrades.

You must install Common Services 3.0.3, before upgrading to 
Campus Manager 4.0.3.

You can upgrade to Campus Manger 4.0.3 by either:

• Using the Campus Manager 4.0.3 CD-ROM. 

For more details, see Installing Campus Manager 4.0.3, page 2-3.

Or

• Using LAN Management Solution 2.5 December 2005 Update on Solaris. 
You can download this from: 

http://www.cisco.com/kobayashi/sw-center/cw2000/lan-planner.shtml 

For more details see, Readme for LAN Management Solution 2.5 December 
2005 Update on Solaris that can be downloaded from the same location. 

When you install Campus Manager 4.0.3, certain data from the previous versions 
of Campus Manager is converted to Campus Manager 4.0.3 format. This data 
includes:

• Seed devices

• Data Collection schedule

• Data Collection filters

• Data Collection debugging options

• User Tracking queries and layouts

• User Tracking jobs and archives 

• User Tracking administration preferences
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• User Tracking usernames, notes, and entries

• SNMP community strings

• Discovery schedule

• Discovery filters

• Discovery debugging options

• Path preferences

• Job schedule

• Job archives

• Topology groups 

• Topology map preferences

• Discrepancies settings

• Syslog settings

Server Requirements
The server requirements for Campus Manager 4.0.3 are the same as that of 
LMS 2.5.1.

The minimum system requirements for CiscoWorks Common Services 3.0.3 and 
Campus Manager 4.0.3 are shown in Table 1-1.

Table 1-1 Server System Requirements Summary 

Requirement Type Minimum Requirement1

System hardware • Sun UltraSPARC IIIi

• CD-ROM drive

Memory (RAM) 512 MB 

Available drive 
space2

2 GB on the partition on which you install the product. The default is /opt

Swap space Swap space equal to double the amount of memory (RAM). For example, if your 
system has 512 MB of RAM, you need 1024 MB of swap space.

/tmp directory Must be on a swap partition
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Checking Required Disk Space
To verify the amount of available disk space in each of the specified partitions and 
directories, enter:

# df -k directory

where directory is the partition or directory for which you want to check the 
available disk space.

System software Solaris 8 (Solaris 2.8) or Solaris 9 (Solaris 2.9)3

Campus Manager supports US-English and Japanese versions of Solaris 
Operating Systems. It does not support any other language version. Set the 
default locale to US-English for US-English version and Japanese for Japanese 
version.

Additional software Netscape 7.0, if you are using the CiscoWorks Home page on the server system

1. If other applications are installed, or the number of devices on your network exceeds 500, the requirements might be greater.

2. For information about verifying disk space, see the “Checking Required Disk Space” section on page 1-5.

3. Patch 106292-05 must not be installed.

Table 1-1 Server System Requirements Summary  (continued)

Requirement Type Minimum Requirement1
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Solaris Patches
Table 1-2 lists the required and recommended patches for Solaris 8 (Solaris 2.8) 
and Solaris 9 (Solaris 2.9).

Use the showrev -p command to verify that these patches have been applied.

Maximum Recommended Load
The maximum recommended load on servers configured with the minimum server 
requirements shown in Table 1-1 is 500 Cisco devices and one client at a time.

If other network management applications are installed on your server, you may 
need additional resources.

Table 1-2 Required and recommended patches for Solaris 

Operating System Required Recommended

Server Client Server Client

Solaris 8 (Solaris 2.8) 111327-05

110945-08

110934-16

110898-09

109326-14

108827-40

108528-29

111626-03

108652-81

108921-21

108940-62

110951-01

110662-02

110615-01

110286-02

110951-05

110662-12

110615-11

108964-06

Solaris 9 (Solaris 2.9) 114224-01

113580-01

112839-04

112233-12

114006-01

112771-14 

112661-06

113244-05

113326-01

112998-03

113713-14

112964-07

113575-05

112970-07

112808-06
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Server Recommendations
To select or configure a server system that best meets your needs, consider the 
number of managed devices.

Table 1-3 shows the recommendations for a server running Common Services and 
Campus Manager Manager. These recommendations produce optimal response 
time while running user reports.

Client Requirements
The minimum client system requirements for CiscoWorks
Common Services 3.0.3 and Campus Manager 4.0.3 are shown in Table 1-4. The 
maximum recommended load on clients configured with the minimum 
requirements shown in Table 1-4 is 2000 Cisco devices.

Table 1-3 Server System Recommendations

Minimum System Configuration No. of Managed Devices

Ultra 10
Memory: 512 MB
Swap space: 1 GB
Available disk space: 40 GB 

0–1000 managed devices

Ultra 10
Memory: 2 GB
Swap space: 2 GB
Available disk space: 80 GB 

1000-2500 managed devices

Ultra 60 (dual processor)
Memory: 2 GB
Swap space: 4 GB
Available disk space: 80 GB

2,500–5,000 managed devices
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Supported Devices
For information about supported devices, access the Supported Devices table at 
the following location on cisco.com:

http://cisco.com/en/US/products/sw/cscowork/ps563/
products_device_support_tables_list.html

Table 1-4 Client System Requirements Summary

 Requirement Type Minimum Requirement

System Software and 
Hardware

• Client system:

– IBM system with at least a 300 MHz Pentium processor running 
Windows (Professional and Server), or Windows XP SP1

Or

– Solaris SPARC station Solaris 8 (Solaris 2.8) or Solaris 9 (Solaris 2.9)

– Color monitor with video card set to 24 bits color depth

Memory (RAM) 512 MB

Browser Any one of these browsers:

• On Windows 2000 and Windows XP clients:

– Microsoft Internet Explorer 6.0.26 and Microsoft Internet Explorer 
6.0.28

– Netscape Navigator 7.1 and Netscape Navigator 7.2

– Mozilla 1.7 and 1.7.5

• On Solaris clients:

– Netscape Navigator 7.0 

– Mozilla 1.7 and Mozilla 1.7.5
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Installing Campus Manager

This chapter describes how to install, uninstall, and reinstall 
Campus Manager 4.0.3. 

You must install Common Services 3.0.3 before you can install 
Campus Manager 4.0.3.

This chapter contains:

• Installation Overview, page 2-2

• Installing Campus Manager 4.0.3, page 2-3

• Reinstalling Campus Manager, page 2-7

• Backing Up and Restoring Data After Installation, page 2-9

• Uninstalling Campus Manager, page 2-12 
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Installation Overview
Table 2-1 is an overview of the Campus Manager 4.0.3 installation tasks. It 
contains references to more detailed information about each task.

Table 2-1 Installation Tasks

Task Steps References

1. Prepare to 
install Campus 
Manager.

Verify that server requirements 
are met.

“Server Requirements” section on page 1-4

2. Install Campus 
Manager.

Run the installation program. “Installing Campus Manager 4.0.3” section 
on page 2-3

3. Verify and 
troubleshoot 
installation.

a. Verify the correct files and 
directories are installed.

b. Analyze installation error 
messages.

 “Understanding Installation Messages” 
section on page A-2 

4. Set up Campus 
Manager

Prepare the system for Campus 
Manager applications and set up 
the applications.

Setting Up Campus Manager Applications, 
page 3-3
2-2
Installation and Setup Guide for Campus Manager 4.0.3 on Solaris

78-17187-01



 

Chapter 2      Installing Campus Manager
Installing Campus Manager 4.0.3
Installing Campus Manager 4.0.3
This section describes how to install Campus Manager 4.0.3. You must install 
CiscoWorks Common Services 3.0.3 before installing Campus Manager 4.0.3. 

For information on installing CiscoWorks Common Services 3.0.3, see the 
Installation and Setup Guide for CiscoWorks Common Services 3.0.3 (Includes 
CiscoView) on Solaris.

Campus Manager gets installed in the same directory where you have installed 
CiscoWorks Common Services 3.0.3.

The Campus Manager 4.0.3 installer automatically updates program files and data 
from previous versions of Campus Manager .

All device updates up to Campus Manager 4.0 SP 2 have been incorporated in 
Campus Manager 4.0.3.

Licensing in Campus Manager 4.0.3
Campus Manager 4.0.3 uses the license of Campus Manager 4.0. If you have a 
licensed version of Campus Manager 4.0, you can install Campus Manager 4.0.3. 

Campus Manager 4.0.3 emulates the licensing behavior of Campus Manager 4.0. 
For example, if the Campus Manager 4.0 license is restricted, 
Campus Manager 4.0.3 is also restricted.

For information on the licensing mechanism in Campus Manager 4.0, see 
Installation and Setup Guide for Campus Manager 4.0 on Solaris.

Installation Notes
If you have configured Common Services in ACS mode (Common Services > 
Server > Security > AAA Mode Setup), while installing RME 4.0.3, you are 
prompted with this message during installation: 

CiscoWorks Server is in ACS mode
The application that you are installing requires new tasks to be 
registered with ACS. If you have already registered this application 
with ACS from another server, you do not need to register it again.
However if you re-register the application, you will lose any custom 
roles that you had created earlier for this application in ACS.
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Enter (Y)es to Register, (N)o to continue without registering, (Q)uit 
: [N]

• If you enter Y, Campus Manager 4.0.3 gets registered with ACS server. 

• If you enter N, Campus Manager 4.0.3 does not get registered with ACS 
server. 

After the installation, you can register Campus Manager 4.0.3 with ACS server, 
using the script, AcsRegCli.pl: 

/opt/CSCOpx/bin/perl /opt/CSCOpx/bin/AcsRegCli.pl -register rme

• If you enter Q, Campus Manager 4.0.3 installation is aborted. 

Running the Installation Program
To install Campus Manager 4.0.3:

Step 1 As root, mount the Campus Manager 4.0.3 CD-ROM, using either of the 
following methods: 

• Mount the CD-ROM on the Campus Manager server system. 

Or

• Mount the CD-ROM on a remote Solaris system, then access the CD-ROM 
from the Campus Manager server system. 

See Appendix B, "Mounting and Unmounting the CD-ROM, page B-1" for 
mounting instructions. 

Step 2 Run the installation program.

Enter:

./setup.sh 

A message appears:

Press Enter to read/browse the following license agreement:
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Step 3 Press Enter to read the license agreement. 

The following message appears at the end of the license agreement:

You must accept this License agreement for the installation to 
proceed.
If you enter N/n, the installation will exit. 
Do you accept all the terms of the proceeding License Agreement? (y/n) 
[n]

If you are upgrading from Campus Manager 4.0, you will not see the license 
agreement.

Step 4 Enter y to accept the license and proceed with the installation.

Or 

Enter n to deny and stop the installation.

If you select y, the following message appears:

For security reasons, Cisco recommends that you change the default 
password for ANI database.
Do you want to change it now, no is the default option.

Step 5 Enter y to change your default Campus Manager database password. 

The following message appears:

Enter ANI database password:
Confirm password:

Step 6 Enter the password, and re-enter to confirm it.

The following message appears:

If no other CiscoWorks application installations are pending, you can 
choose to start CiscoWorks Daemons.
Do you want to restart CiscoWorks Daemons at the end of this 
installation?(y/n) [n]:

Step 7 Enter y to restart the CiscoWorks daemons after installation.

The following message appears:

Exiting installation beyond this point might result in system 
instability.
Do you want to continue the installation? (y/n) [y]:
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Step 8 Enter y to continue the installation.

The installation program displays messages about the various packages being 
installed and the services being started. 

The packages include application software and device adapter packages for all 
devices that can be managed with Campus Manager applications. The following 
message appears:

To ensure that you retain the latest device support and bug fixes, 
please install the latest Service Pack (SP) for Campus Manager 4.0.3

You can download the latest SP from 
http://www.cisco.com/cgi-bin/tablebuild.pl/cw2000-campus.
Please refer to the Installation and Setup Guide for details.

User Tracking Utility 1.0 is not compatible with Campus Manager 4.0.3
User Tracking Utility 1.1.1 is available for Campus Manager 4.0.3.
You can download the latest UTU from 
http://www.cisco.com/cgi-bin/tablebuild.pl/cw2000-campus-crypto.

The installation completes. 

After installing Campus Manager 4.0.3, you can verify the process status by 
running NMSROOT/bin pdshow

If errors occurred during installation, check the installation log file 
/var/tmp/ciscoinstall.log. For information about troubleshooting, see 
Appendix A, “Troubleshooting the Installation.”

After the installation completes, do either of the following:

• If you have data from the earlier version of Campus Manager to import into 
Campus Manager 4.0.3, see the “Backing Up and Restoring Data After 
Installation” section on page 2-9.

• If you do not have data to import, continue to Chapter 3, “Preparing to Use 
Campus Manager.”

After Campus Manager 4.0.3 is installed, Topology Services allows you to either 
convert the saved view layouts in the new Campus Manager 4.0.3 format or 
directly use the default view layouts generated by Campus Manager 4.0.3. See the 
“Upgrading Saved View Layouts From Topology Services” section for more 
information.
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Reinstalling Campus Manager
If you had any problems with previous installation, you can reinstall Campus 
Manager.

To run the reinstallation program:

Step 1 As root, mount the Campus Manager 4.0.3 CD-ROM. You can either: 

• Mount the CD-ROM on the CiscoWorks server system. 

Or 

• Mount the CD-ROM on a remote Solaris system, then access the CD-ROM 
from the CiscoWorks server system. 

See Appendix B, “Mounting and Unmounting the CD-ROM,” for detailed 
mounting instructions. 

Step 2 Run the installation program.

Enter:

./setup.sh 

A prompt appears:

Campus Manager 4.0.3 has been detected on your system. Are you sure 
you want to reinstall? (y/n)? [n]

Step 3 Enter y to continue to install or n to cancel. 

If you select y, the following message appears:

For security reasons, Cisco recommends that you change the default 
password for ANI database.
Do you want to change it now, no is the default option.

Step 4 Enter y to change your default Campus Manager database password. 

The following message appears:

Enter ANI database password:

Step 5 Enter the password, and re-enter to confirm it.

The installation program displays messages about the various packages being 
installed and the services being started. 
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The packages include application software and device adapter packages for all 
devices that can be managed with Campus Manager applications. 

The following message appears:

To ensure that you retain the latest device support and bug fixes, 
please install the latest Service Pack (SP) for Campus Manager 4.0.3.
You can download the latest SP from 
http://www.cisco.com/cgi-bin/tablebuild.pl/cw2000-campus.
Please refer to the Installation and Setup Guide for details.

User Tracking Utility 1.0 is not compatible with Campus Manager 4.0.3
User Tracking Utility 1.1.1 is available for Campus Manager 4.0.3.
You can download the latest UTU from 
http://www.cisco.com/cgi-bin/tablebuild.pl/cw2000-campus-crypto.
Please refer to the Installation and Setup Guide for details

The re-installation completes.

After installing Campus Manager 4.0.3, you can verify the process status by 
running NMSROOT/bin pdshow

After installing Campus Manager 4.0.3, you can manually import your existing 
database to the system on which CiscoWorks is installed if it was not 
automatically imported during installation. See the “Backing Up and Restoring 
Data After Installation” section on page 2-9.

After Campus Manager 4.0.3 is installed, Topology Services allows you to either 
convert the saved view layouts in the new Campus Manager 4.0.3 format or 
directly use the default view layouts generated by Campus Manager 4.0.3. See the 
“Upgrading Saved View Layouts From Topology Services” section for more 
information.

Upgrading Saved View Layouts From Topology Services
Use the following procedure to upgrade saved topology view layouts generated by 
the previous version of Campus Manager to the new Campus Manager 4.0.3 
format. The following view layouts are upgraded:

• Layer 2 View

• Unconnected Device View

• LAN Edge View
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To upgrade saved view layouts:

Step 1 Start Topology Services. (Campus Manager > Topology Services)

Step 2 Select File > Upgrade View Layouts.

Step 3 Select the view layout you want to upgrade.

Step 4 Click Upgrade to upgrade the selected view layout.

Topology Services upgrades the selected view layout to the Campus Manager 
4.0.3 format. 

Step 5 Select the corresponding view layout from the side panel in Topology Services to 
display this layout.

The upgraded view layout might not be formatted in exactly the same as the 
previous version of the view layout. 

Backing Up and Restoring Data After Installation
This section describes how to back up and restore data from previous versions of 
Campus Manager. You can back up and restore data from:

• Campus Manager 3.2.x

• Campus Manager 3.3.x

• Campus Manager 4.0

• Campus Manager 4.0 Service Pack 1

• Campus Manager 4.0 Service Pack 2

where .x refers to the IDU upgrades.

This section consists of:

• Backing Up Data Using GUI

• Backing Up Data Manually From Campus Manager

• Restoring Data Manually From Campus Manager
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Backing Up Data Using GUI
You can schedule immediate, daily, weekly, or monthly automatic database 
backups. 

To back up data:

Step 1 In the CiscoWorks Homepage, select Common Services > Server  > Admin > 
Backup. 

The Backup page appears. 

Step 2 Enter the appropriate information in the following fields: 

Step 3 Click Apply. 

Table 2-2 Backing Up Data

Field Description

Backup Directory Location of the backup directory. We 
recommend that your target location 
be on a different partition than the 
CiscoWorks installation location. 

Runtype Select the desired check box. You have 
options to schedule immediate, daily, 
weekly, or monthly backups. 

Time From the drop-down lists, select the 
time and date. 

• If you schedule a weekly backup, 
select the day of the week from the 
drop-down list. 

• If you schedule a monthly backup, 
select the day of the month from 
the drop-down list. 

Generations Maximum number of backups to be 
stored in the backup directory. 
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Backing Up Data Manually From Campus Manager
To manually back up saved data in earlier versions of Campus Manager:

Step 1 Stop the daemon manager on the local machine on which the previous version of 
Campus Manager is installed. Enter:
/etc/init.d/dmgtd stop

Step 2 Export CiscoWorks data by entering:

NMSROOT/bin/perl NMSROOT/bin/backup.pl -d /backup dir

You should enter the path where you want to export CiscoWorks Common 
Services data. The script command will back up the CiscoWorks data.

Step 3 Start the daemon manager by entering:
/etc/init.d/dmgtd start

Step 4 Copy the backed up directory to the remote machine.

Restoring Data Manually From Campus Manager
To restore data manually:

Step 1 Stop the daemon manager on the local machine on which the previous version of 
Campus Manager is installed by entering:
/etc/init.d/dmgtd stop

Step 2 Restore CiscoWorks data by entering:
NMSROOT/opt/CSCOpx/bin/perl /opt/CSCOpx/bin/restorebackup.pl -d 
/backup dir

You should enter the path where you want the data to be restored.

Step 3 Start the daemon manager by entering:
NMSROOT /etc/init.d/dmgtd start
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Uninstalling Campus Manager 
The uninstallation program removes Campus Manager 4.0.3 files and settings. 
The uninstall option enables you to remove only Campus Manager 4.0.3 or 
remove CiscoWorks Common Services 3.0.3 as well.

You must use the Campus Manager 4.0.3 uninstallation program to remove the 
product. You could damage your system, if you attempt to remove 
Campus Manager Manager 4.0.3 or its components manually.

Caution Uninstalling Campus Manager deletes the Campus Manager database.

To remove Campus Manager Manager 4.0.3 or other major components:

Step 1 Enter the following commands as root to start the uninstall program:

# /opt/CSCOpx/bin/uninstall.sh

where /opt/CSCOpx is the default installation directory. If you have specified a 
different directory while installing CiscoWorks Common Services, substitute the 
name of the directory.

A prompt similar to the following appears:

1) Cisco View 6.1.2
2) Integration Utility 1.6
3) CiscoWorks Common Services 3.0.3
4) Campus Manager 4.0.3
5) All of the above

Select one or more of the items using its number separated by comma or 
enter q to quit [q]

Step 2 Enter the number that corresponds to it (in this case, 4).

• You can select one or more of the items using its number separated by comma 
or enter q to quit. 

• To remove Campus Manager, CiscoWorks Common Services, CiscoView and 
Integration Utility, enter the number that corresponds to all of the above (in 
this case, 5).

A prompt appears, where the default selection is indicated in brackets:

Are you sure you want to uninstall: Campus Manager 4.0.3 (y/n)? [n]
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Step 3 Enter y to continue to uninstall or n to cancel.

If any other prompts appear, respond appropriately.

The uninstallation program displays a series of messages. Ignore any additional 
messages that ask if you want to remove packages.

The uninstall messages are written to the /var/tmp/ciscouninstall.log file.

After the uninstallation script successfully completes, the following message 
appears:

All files were deleted successfully.
2-13
Installation and Setup Guide for Campus Manager 4.0.3 on Solaris

78-17187-01



 

Chapter 2      Installing Campus Manager
Uninstalling Campus Manager
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Preparing to Use Campus Manager

This chapter describes the various administrator and application setup tasks that 
you must perform after installing Campus Manager 4.0.3. 

This chapter contains:

• Overview of Campus Manager Setup Tasks

• Accessing the CiscoWorks Server

• Performing Administrator Tasks

• Setting Up Campus Manager Applications

• Logging Out as Administrator
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Overview of Campus Manager Setup Tasks
Table 3-1 provides an overview of the Campus Manager 4.0.3 setup tasks and 
references to more detailed information about each task. 

Accessing the CiscoWorks Server
You must set up the client before using Campus Manager. See Installation and 
Setup Guide for CiscoWorks Common Services 3.0 (Includes Ciscoview) on 
Solaris for configuring browser and client systems.

To access Campus Manager, enter the URL of the CiscoWorks Server in your web 
browser:

http://server_name:1741
https://server_name:443 (for SSL mode)

where server_name is the name of the CiscoWorks Server. If you were prompted 
to supply a port number for the CiscoWorks Server during the installation, use that 
port number in the URL. The default port number is 1741 (443 if SSL is enabled).

Table 3-1 Overview of Campus Manager Setup Tasks

Tasks References

1. Access the CiscoWorks Server. “Accessing the CiscoWorks Server” 
section on page 3-2

2. Perform administrator setup tasks. “Logging In as Administrator” section 
on page 3-3

3. Start and configure applications. “Setting Up Campus Manager 
Applications” section on page 3-3 

4. Log out of the Server. “Logging Out as Administrator” 
section on page 3-10
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Performing Administrator Tasks
If you cannot access the CiscoWorks Server or the CiscoWorks Home page is not 
displayed correctly, refer to Appendix A, “Troubleshooting the Installation.”

After you access the CiscoWorks Server, see the “Performing Administrator 
Tasks” section on page 3-3.

Performing Administrator Tasks
After accessing the CiscoWorks Server, you must log in as the administrator and 
set up the server for other users.

Logging In as Administrator
To log in as administrator:

Step 1 Enter the system administrator username and password in the Login page.

Step 2 Click Login.

The CiscoWorks Homepage appears.

After you log in as the administrator, continue to the “Setting Up Campus 
Manager Applications” section on page 3-3.

To log out the CiscoWorks Server, see the “Logging Out as Administrator” section 
on page 3-10 for information.

Setting Up Campus Manager Applications
This section describes the tasks that you must perform to set up the 
Campus Manager 4.0.3 applications. Some of these tasks require the 
administrator login.

This section contains:

• Setting Up Your Network

• Configuring Device Discovery
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• Setting Up Topology Services

• Setting Up Path Analysis

Setting Up Your Network
To ensure that the Campus Manager Server successfully discovers the devices in 
your network, you must set up your network correctly. Table 3-2 lists the required 
tasks for each application, marked by x. 

See the User Guide for Campus Manager 4.0.3 for more information.

Table 3-2 Network Setup Tasks

Network Setup Requirement
Topology 
Services 

User 
Tracking 

Path 
Analysis 

VLAN Port 
Assignment

Discrepancy 
Reports

Connect to seed device x x x x x

Enable Simple Network Management 
Protocol (SNMP)

x x x x x

Enable Cisco Discovery Protocol 
(CDP)

x x x x x

Enable Call Detail Record (CDR) – – x – –

Set a unique sysName variable on 
devices

x x x x –

Enable Integrated Local 
Management Interface (ILMI) on 
ATM devices

x x x x x

Configure DNS x x x x x

Configure VLAN Trunk Protocol 
(VTP)

x x x x x

Configure VLAN trunks on Fast 
Ethernet and Gigabit Ethernet

x x x x x
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After you set up your network, continue to the “Configuring Device Discovery” 
section on page 3-5. 

Configuring Device Discovery
You can modify SNMPv2 and SNMPv3 credentials using the Discovery > SNMP 
Settings option from the Admin tab in the Campus Manager Administration 
window.

To configure Device Discovery Settings:

Step 1 Go to Campus Manager > Administration > Device Discovery > Discovery 
Settings.

The Device Discovery Settings dialog box appears.

Step 2 Specify the seed device and IP address range.

Step 3 Click Apply to save the changes.

Step 4 Click OK to start Device Discovery.

If you do not specify the IP address range, Device Discovery tries to discover as 
many devices as it can based on the community strings and connectivity.

For more information, see Specifying Seed Device Online help.

After you set up your network, continue to the “Configuring Data Collection” 
section on page 3-6. 

Create the default configuration 
server for ATM LAN Emulation 
(LANE)

x x x x x

Enable source routing – – x – –

Table 3-2 Network Setup Tasks (continued)

Network Setup Requirement
Topology 
Services 

User 
Tracking 

Path 
Analysis 

VLAN Port 
Assignment

Discrepancy 
Reports
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Verifying Device Discovery

To verify the status of Device Discovery, go to Campus Manager > 
Administration. In the Campus Manager Administration dashboard that appears, 
you can view the status of Device Discovery. 

Configuring Data Collection
You should have run Device Discovery atleast once before starting Data 
Collection, or the devices should be available in Device and Credential Repository 
(DCR). 

To configure Data Collection, go to Campus Manager > Administration > 
Campus Data Collection > Data Collection Filters. The Data Collection Filter 
Settings dialog box appears.

Specifying VTP Domain

Step 1 In the Data Collection Filter Settings dialog box, select VTP Domain and click 
Configure.

The VTP Domain Filter dialog box appears.

Step 2 From the drop-down list, select either of these options:

• Manage devices in specified VTP domains.

• Do not manage devices in specified VTP domains.

Step 3 Enter the VTP domains that are to be used to limit data collection and click Apply.

You will be prompted to click OK to start Data Collection or to click Cancel to 
apply only the settings.
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Specifying IP Address Range

Step 1 In the Data Collection Filter Settings dialog box, select IP Address Range and 
click Configure.

The IP Range Filter dialog box appears.

Step 2 From the drop-down list, select either of these options:

• Manage devices in specified IP Address Range

• Do not manage devices in specified IP Address Range

Step 3 Specify the IP Address Range and click Apply.

A confirmation dialog box appears.

Step 4 Click OK to start Data Collection.

Note You can apply either the VTP domain or the IP Address Range, but not both.

If you do not specify the IP address range or VTP domain, Campus Manager takes 
all devices from the DCR. The number of devices for which data can be collected 
depends upon your licence limit.

Verifying Data Collection

To verify the status of Data Collection, go to Campus Manager > 
Administration. In the Campus Manager Administration dashboard that appears, 
you can view the status of Data Collection.
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Setting Up Topology Services
To set up Topology Services:

Step 1 Verify that the Campus Manager Server is running.

Step 2 Make sure the Campus Manager Server has managed the devices. 

To verify this, go to the Data Collection Metrics page. (Campus Manager > 
Administration > Reports > Data Collection Metrics)

Step 3 Select Campus Manager > Topology Services from CiscoWorks Homepage.

For more information, see the Topology Services Online help.

Verifying Topology Services

To verify that Topology Services is working correctly, do the following:

• Verify that all devices and interfaces are discovered. 

Correctly discovered devices and interfaces appear in green in the 
Topology Services window.

• Verify that devices displayed in red are SNMP reachable and have correct 
community strings.

• Verify that all VLANs and ELANs are discovered and that their port 
assignments are correct.

The devices are displayed in Topology services only after data collection.

For more information, see the Topology Services Online help.
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Setting Up Path Analysis
To set up Path Analysis:

Step 1 Install and configure a DNS server on your network. 

A DNS server is required for Campus Manager. For devices with multiple IP 
addresses, there should be a single DNS entry that includes all IP addresses.

Step 2 Specify correct read community strings on all devices. 

Step 3 Specify correct write community strings for multi-layer switching shortcut path 
determination on Catalyst 5000 devices.

Step 4 Edit the VLAN/ELAN Mapping Table. 

This table provides mapping of VLANs and ELANs to subnets. 

These mappings are auto-discovered based on information gathered by 
Topology Services and User Tracking. 

In some cases, the information might be incomplete. In these cases, you can edit 
a VLAN/ELAN mapping table to supplement the Topology Services and 
User Tracking information. If subnet mappings are not correct, Layer 2 traces on 
those subnets might fail.

Step 5 Enable Cisco Discovery Protocol (CDP) on all Cisco devices. 

If CDP is not enabled, these devices will not appear on Layer 2 path traces.

Step 6 Enable source routing on your network. 

This is required if you plan to run path traces outside of the domain known to 
Topology Services.

For more information, see the Path Analysis Online help.
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Verifying Path Analysis

To verify that Path Analysis is working correctly, do the following:

• Start Topology Services and make sure that all devices, interfaces, and links 
are managed correctly. 

Correctly managed devices appear in green in the Topology Services window. 

• Verify that all VLANs and ELANs are managed with correct port 
assignments.

• Start User Tracking and run User Tracking major acquisition with the Ping 
Sweep option enabled to verify that all end-user stations are managed.

• Run nslookup on several known devices in the command shell. 

• Verify that DNS lookup works and takes one second or less.

• Verify the Subnet Mapping table entries. 

Each VLAN and ELAN entry should have any corresponding subnets listed. 
Any subnets that do not correspond to a VLAN or ELAN should be in a 
Subnet row.

• Run a few traces between endpoints known to User Tracking or Topology 
Services and verify that the trace completed successfully.

For troubleshooting information, see the Path Analysis Online help.

Logging Out as Administrator
To end your administrator tasks, you must log out of Campus Manager. 

Step 1 Close all secondary browser windows. 

You should have only one browser window opened displaying the Campus 
Manager interface.

Step 2 Click Logout. 

The Login page replaces the navigation tree.
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Troubleshooting the Installation

This appendix provides troubleshooting information for Campus Manager 4.0.3 
installation and setup.

This appendix contains:

• Logging In After Upgrading

• Understanding Installation Messages

• Failing to Delete a Package During Uninstallation

• Accessing the CiscoWorks Server

• FAQs on Service Packs
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Logging In After Upgrading
If the Login window on the CiscoWorks Home page does not appear correctly 
when you attempt to log in for the first time after upgrading, clear your browser 
cache then re-enter the server URL in your browser.

To clear the browser cache in Microsoft Internet Explorer:

Step 1 Select Tools > Internet Options. 

The Internet Options dialog box opens.

Step 2 Click the General tab.

Step 3 Click Delete Files and click OK in the Delete Files dialog box.

To clear the browser cache in Netscape Navigator:

Step 1 Select Edit > Preferences. 

The Preferences dialog box opens.

Step 2 Select Advanced >Cache.

Step 3 Click Clear Cache and click OK.

Understanding Installation Messages
After verifying that the correct files are installed, check the 
/var/tmp/ciscoinstall.log file for installation errors. 

The following types of installation messages might appear:

• Information messages—Display important details

• Warning messages—Inform you that something might be wrong with a 
particular process, but the process will complete

• Error messages—Inform you that a particular process could not complete
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Understanding Installation Messages
Table A-1 shows error messages that might occur during installation and 
describes the reasons for the errors.

Table A-1 Installation Error Messages

Message Reason for Message User Action

Install CiscoWorks Common 
Service 3.0.3 first

CiscoWorks Common Service 
Service Pack 3.0.3 is not 
installed.

Install CiscoWorks Common 
Service Service Pack 3.0.3, 
and then install Campus 
Manager 4.0.3.

Access problem with directory. The installation program cannot 
access the product directory that 
you specified.

Check the permissions on the 
directory directory. 

Bad installation root dir. You are trying to install the 
product in an unusable directory.

Install the product on a 
different directory.

Base package did not install. 
Exiting.

The installation program cannot 
install a package that is required 
for the product.

Contact your technical support 
representative.

Cannot backup /etc/services, no 
change will be made.

The installation program could 
not make a copy of /etc/services 
before modifying it.

Make sure that there is enough 
space in /tmp.

Cannot become owner of file in 
directory directory.

You cannot become the owner of 
a file in the directory that you 
specified as the product root.

Check the permissions on the 
directory that you specified.

Cannot change ownership of 
library. Exiting.

The installation program could 
not write to the product root 
directory.

Check the permissions on the 
directory that you specified.

Cannot create directory. The installation program could 
not write to the directory that you 
specified.

Check the permissions on the 
directory that you specified.

Cannot create symlink: ln -s root 
/opt/CSCOpx.

The installation program cannot 
create a link from /opt/CSCOpx 
to the product root directory that 
you specified.

Contact your technical support 
representative.

Cannot determine the CiscoWorks 
Common Services version.

The installation disk is corrupted. Contact your technical support 
representative.
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Cannot determine the version of 
product.

The installation program was 
unable to determine the product 
version.

Contact your technical support 
representative.

Cannot make list of packages for 
installation.

The installation has suffered a 
major failure.

Contact your technical support 
representative.

Cannot upgrade. Upgrade failed. Contact your technical support 
representative.

Copy setupdir to $NMSROOT 
failed.

The installation program could 
not write to product root 
directory.

Check the permissions on the 
root.

Installation in progress. You are already running an 
installation on this machine.

Run only one installation 
program at a time.

Missing file file. The installation program could 
not find the file file.

Contact your technical support 
representative.

No syslog facility is available. There are no available syslog 
facilities.

Make one of the facilities 
available.

Not enough disk space: root. You have picked a product root in 
a file system with insufficient 
space to load the product.

Make at least 2 GB of disk 
space available on the partition 
on which you install the 
product.

Package verification failed: pkg 
aborting.

While attempting to load our 
packages on the machine, one of 
the packages loaded incorrectly.

Contact your technical support 
representative.

Syslog is not running. The installation program was 
unable to start syslogd on this 
machine.

Restart syslogd.

The components have dependency 
errors.

The installation program suffered 
a major failure.

Contact your technical support 
representative.

Table A-1 Installation Error Messages (continued)

Message Reason for Message User Action
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Failing to Delete a Package During Uninstallation
If you try to remove Campus Manager Manager 4.0.3 but the uninstallation 
program fails to delete a package, try running the uninstallation program again. 
Several circumstances can cause a package not to uninstall successfully. Running 
the uninstallation program again will usually remove it.

Accessing the CiscoWorks Server
The CiscoWorks server uses port 1741 by default (443 if SSL is enabled). This 
port is normally used by web servers. If you see an error message that an existing 
web server is already configured to run on port 1741, and the alternative port 1744 
is used instead, verify that you entered the correct URL for the server:

http://server_name:1744

where server_name is the name of the machine on which CiscoWorks was 
installed and 1744 is the alternative port on which CiscoWorks is installed if port 
1741 is in use.

If you still cannot access the server, enter the following command to make sure 
your server is running:

# ping server_name

If you get a message that the server is alive, and get a proxy error when you try to 
connect to the server, make sure the proxy is set up correctly. If your server is 
configured to use a proxy server outside the firewall, you will get proxy errors if 
you have configured the proxy to ignore requests to a certain machine, set of 
machines, or domain. 

User must be root. You must be logged in as root to 
install the product.

Log in as root and enter the 
correct password.

Wrong OS. This operating system is not 
Solaris or not a supported version 
of Solaris.

Make sure that you are running 
Solaris 2.8 or Solaris 2.9.

Table A-1 Installation Error Messages (continued)

Message Reason for Message User Action
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You can specify a proxy server in Netscape Navigator under Edit > 
Preferences >  Advanced > Proxies and in Internet Explorer under Tools >  
Internet Options >  Connections > LAN Settings. 

Your proxy is set up incorrectly if: 

• You receive an error message informing you that you are using a proxy 
outside the firewall.

• The proxy server recognizes www-int as an internal server, so it does not send 
proxy requests to that server.

• You set up a new internal server, www-nms, but when you make a request to 
the proxy server, it does not recognize www-nms as an internal server and 
proxies the request.

• The proxy server outside the firewall tries to request data from a server inside 
the firewall, and the request is blocked.

• You get a Connection Refused error from the proxy server.

FAQs on Service Packs
The following are the Frequently Asked Questions (FAQs) on Service Packs.

Q. What is an SP? Why should I install the latest SP?

A. SP (Service Pack) for Campus Manager is a downloadable package 
containing a collection of updated files to provide you with support for new 
devices. In addition, the SP contains fixes to certain known problems, as well 
as fixes to newly discovered problems. SPs are available for downloading 
from Cisco.com.

Q. From where can I download a Service Pack?

A. To retain support for new devices, we recommend that you download and 
install the latest SP for Campus Manager from:

http://www.cisco.com/cgi-bin/tablebuild.pl/cw2000-campus
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Q. How do I know which version of SP I have installed?

A. To check the version of SP installed on your system, from the CiscoWorks 
Homepage, go to Software Center > Software Update > 
Campus Manager. 
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Mounting and Unmounting the 
CD-ROM

This appendix describes how to mount and unmount the Campus Manager 4.0.3 
CD-ROM on a Solaris system and provides general information only. For more 
detailed instructions, consult your Sun documentation.

You can install Campus Manager 4.0.3 from a CD-ROM mounted on the 
Campus Manager server system or from a CD-ROM mounted on a remote Solaris 
system. After you complete the Campus Manager 4.0.3 installation, you must 
unmount the CD-ROM drive.

This appendix contains:

• Mounting a Local CD-ROM Drive

• Mounting a Remote CD-ROM Drive

• Unmounting a Local CD-ROM Drive

• Unmounting a Remote CD-ROM Drive
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Mounting a Local CD-ROM Drive
To mount a local CD-ROM drive:

Step 1 Insert the Campus Manager 4.0.3 CD-ROM.

Step 2 Become the superuser by entering the command su and the root password at the 
command prompt, or log in as root. The command prompt changes to the pound 
sign (#).

If the /cdrom directory does not already exist, enter the following command to 
create it:

# mkdir /cdrom

Step 3 Mount the CD-ROM drive. 

Note The vold process manages the CD-ROM device and performs the 
mounting. The CD-ROM might automatically mount onto the 
/cdrom/cdrom0 directory. 

• If you are running File Manager, a separate File Manager window displays the 
contents of the CD-ROM.

• If the /cdrom/cdrom0 directory is empty because the CD-ROM was not 
mounted, or if File Manager did not open a window displaying the contents 
of the CD-ROM, verify that the vold daemon is running by entering:

# ps -e | grep vold | grep -v grep

• If vold is running, the system displays the process identification number of 
vold. If the system does not display anything, restart the daemon by entering:

# /usr/sbin/vold &

• If the vold daemon is running but did not mount the CD-ROM, stop the vold 
daemon and then restart it. To stop the vold process, you must know the 
process identification number. If you do not know the process identification 
number, you can get it by entering:

# ps -ef | grep vold | grep -v grep
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Step 4 Stop the vold process by entering:

# kill -15 process_ID_number

Step 5 Restart the vold process by entering:

# /usr/sbin/vold &

If you encounter problems using the vold daemon, enter the following command 
to mount the CD-ROM:

# mount -F hsfs -r ro /dev/dsk/cxtyd0sz /cdrom/cdrom0

where x is the CD-ROM drive controller number, y is the CD-ROM drive SCSI ID 
number, and z is the slice of the partition on which the CD-ROM is located.

You have now mounted the CD-ROM drive. See Chapter 2, “Installing Campus 
Manager” for instructions on installation.

Mounting a Remote CD-ROM Drive
To mount a remote CD-ROM drive:

Step 1 Insert the Campus Manager 4.0.3 CD-ROM into the CD-ROM drive of the remote 
machine.

Step 2 Become the superuser on the remote machine by entering the command su and the 
root password at the command prompt, or log in as root. The command prompt 
changes to the pound sign (#).

If the /cdrom directory does not already exist, enter:

# mkdir /cdrom

Step 3 Mount the CD-ROM drive. 

Note The vold daemon process manages the CD-ROM device and performs the 
mounting. The CD-ROM might automatically mount onto the 
/cdrom/cdrom0 directory. 
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• If you are running File Manager, a separate File Manager window displays the 
contents of the CD-ROM. 

• If the /cdrom/cdrom0 directory is empty because the CD-ROM was not 
mounted, or if File Manager did not open a window displaying the contents 
of the CD-ROM, verify that the vold daemon is running by entering:

# ps -e | grep vold | grep -v grep

• If vold is running, the system displays /usr/sbin/vold. If the system does not 
display anything, restart the daemon by entering:

# /usr/sbin/vold &

• If the vold daemon is running but did not mount the CD-ROM, stop the vold 
daemon and then restart it. To stop the vold process, you must know the 
process identification number. If you do not know the process identification 
number, you can get it by entering:

# ps -ef | grep vold | grep -v grep

Step 4 Stop the vold process by entering the following command:

# kill -15 process_ID_number

Step 5 Restart the vold process by entering the following command:

# /usr/sbin/vold &

If you encounter problems using the vold daemon, enter the following to mount 
the CD-ROM:

# mount -F hsfs -o ro /dev/dsk/cxtyd0sz /cdrom/cdrom0

where x is the CD-ROM drive controller number, y is the CD-ROM drive SCSI ID 
number, and z is the slice of the partition on which the CD-ROM is located.

Step 6 Use a text editor to create an /etc/dfs/dfstab file, if one does not exist. 

Step 7 Add the following line to the /etc/dfs/dfstab file:

share -F nfs -o ro /cdrom/cdrom0
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Step 8 Make sure your remote machine is enabled as an NFS server by entering:

# ps -ef | grep nfs | grep -v grep

The output of this command indicates whether the /usr/lib/nfs/nfsd and 
/usr/lib/nfs/mountd daemons are running. If they are not running, enable your 
machine as an NFS server by entering:

# /etc/init.d/nfs.server start

If your machine is enabled as an NFS server, enter one of the following:

# share

or

# shareall

Step 9 Log in to the machine on which you want to install Campus as superuser by 
entering the command su and the root password, or log in as root.

Step 10 Create a /cdrom directory, if one does not already exist, by entering:

# mkdir -p /cdrom/cm403

Step 11 To mount the CD-ROM drive, enter:

# /usr/sbin/mount -r remote_machine_name:/cdrom/cdrom0 /cdrom/cm403

You have now mounted the CD-ROM drive. See Chapter 2, “Installing Campus 
Manager” for installation instructions.

Unmounting a Local CD-ROM Drive
To unmount a local CD-ROM drive:

Step 1 As root, enter: 

# cd
# umount /cdrom/cdrom0 

Step 2 Remove the CD-ROM and store it in a safe place.
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Unmounting a Remote CD-ROM Drive
To unmount a remote CD-ROM drive:

Step 1 As root, enter the following on the local machine:

# umount /cdrom/cm403

Step 2 As root, enter the following on the remote machine:

# umount /cdrom/cdrom0

Step 3 Remove the CD-ROM and store it in a safe place.
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User Tracking Utility

CiscoWorks User Tracking Utility 1.1.1 (UTU) is a desktop utility that provides 
quick access to useful information about users or hosts discovered by the 
Campus Manager User Tracking application. 

This chapter contains:

• Understanding UTU, page C-1

• Hardware and Software Requirements for UTU, page C-2

• Downloading UTU, page C-3

• Installing UTU, page C-3

• Accessing UTU, page C-5

• Configuring UTU, page C-6

• Uninstalling UTU, page C-7

• Upgrading to UTU 1.1.1, page C-8

• Reinstalling UTU, page C-9

Understanding UTU
User Tracking Utility allows users with Help Desk access to search for users or 
hosts discovered by Campus Manager User Tracking application. UTU comprises 
a server-side component and a client utility.

To use UTU, Campus Manager must be installed and accessible through the 
network.
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Table C-1 explains certain terms and definitions used in User Tracking Utility.

Hardware and Software Requirements for UTU
Table C-2 lists the minimum system requirements for UTU 1.1.1.

Table C-1 Definitions

Term Definition

Host Any UNIX or Windows system discovered by 
User Tracking.

Host Name Name of the discovered host.

Campus Manager 
Server

Host name or IP address of CiscoWorks server on which 
you have installed Campus Manager.

Port • Port number to which the host is connected

• Port number on which Campus Manager is running on 
the CiscoWorks server

Subnet Subnet to which the host belongs.

User Name Name of the user who has logged into the host.

Table C-2 System Requirements

Requirement Type Minimum Requirements

System hardware IBM PC–compatible computer with Intel Pentium processor.

System software Windows 2000 (Professional or Server) with Service Pack 3 
or higher, Windows XP with Service Pack 2 or higher.

Memory (RAM) 128 MB

Additional 
required software

Campus Manager 4.0.3

Network 
Connectivity

Campus Manager 4.0.3 must be running and accessible 
through the network
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Downloading UTU
UTU requires CiscoWorksUserTrackingUtility1.1.1.exe file to be downloaded 
and installed.

Step 1 Locate the file CiscoWorksUserTrackingUtility1.1.1-k9.zip at:

http://www.cisco.com/cgi-bin/tablebuild.pl/cw2000-campus-crypto

This zip file contains CiscoWorksUserTrackingUtility1.1.1.exe and setup.iss file 
(required for silent installation).

Step 2 Extract the file using any file extractor such as WinZip.

Installing UTU
To install UTU in normal installation mode:

Step 1 Log into the system with local system administrator privileges.

Step 2 Navigate to the directory that contains CiscoWorksUserTrackingUtility1.1.1.exe.

Step 3 Double-click CiscoWorksUserTrackingUtility1.1.1.exe to begin installation.

The User Tracking Utility Welcome screen appears.

Step 4 Click Next.

The Choose Destination Location dialog box appears. By default, UTU is 
installed in the directory C:\Program Files\CSCOutu.

Step 5 Click Next to install UTU in the default directory.

or

a. Click Browse to choose a different directory and click OK.

b. Click Next to continue with the installation.

The Configure CiscoWorks LMS Server Details dialog box appears.

Step 6 Enter the name or IP address of the server on which Campus Manager is installed. 

Step 7 Enter the port number of the Campus Manager server. The default port number is 
1741.
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Appendix C      User Tracking Utility
Step 8 Click Next.

The following message appears:

Is CiscoWorks LMS Server SSL Enabled?

Step 9 Click Yes if the Campus Manager server is SSL enabled, otherwise, click No.

The Configure LMS Server Authentication dialog box appears. You can also 
configure these server details after installation.

Step 10 Enter a valid CiscoWorks Campus Manager server user name and password.

This is used to verify the validity of the user when searching for users or hosts.

Step 11 Confirm the password and click Next.

The Setup Complete dialog box appears.

Step 12 Click Finish to complete the installation.

User Tracking Utility is installed at the destination location you specified in 
Step 5 above. However, it does not create a program group under Start > 
Programs.

You cannot re-install UTU on a system that already has this application installed 
on it. You must check for existing installations of UTU before beginning a fresh 
installation.

To install UTU in silent mode, enter the following at the command prompt:

exe-location\CiscoWorksUserTrackingUtility1.1.1.exe –a –s 
–f1file-location\setup.iss

where

• exe-location is the directory where you have 
CiscoWorksUserTrackingUtility1.1.1.exe

• file-location is the directory where you have the setup.iss file.

Do not use space after the -f1 option. Use the complete path for file-location.

For example:

If the install directory for UTU is c:\utu, enter the following at the command 
prompt:

c:\utu\CiscoWorksUserTrackingUtility1.1.1.exe -a -s 
-f1c:\utu\setup.iss
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To configure the server information, modify the setup.iss file before running the 
silent install. Edit the following fields:

[SdShowDlgEdit2-0]
szEdit1= <hostname>
szEdit2= <server-port>
Result=1
[AskYesNo-0]
Result=1           <1- SSL Enabled, 0 - SSL Disabled>
[SdShowDlgEdit3-0]
szEdit1=<username>
szEdit2=<password>
szEdit3=<password>

You cannot re-install UTU on a system that already has this application installed 
on it. You must check for existing installations of UTU before beginning a fresh 
installation.

To confirm UTU installation on your system, right-click the taskbar and select the 
Toolbar option in your machine. You can find the User Search Band option in the 
popup menu.

Accessing UTU
To display the UTU desktop band on the taskbar: 

Step 1 Right-click the taskbar of the machine on which you installed UTU.

Step 2 Select Toolbars > User Search Band, as shown in Figure C-1.
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Figure C-1 Selecting the Toolbar

The UTU desktop band appears on the taskbar with the title User Information.

Configuring UTU
You must configure UTU only if you want to change the Campus Manager server 
configurations that you entered while installing UTU.

To configure UTU:

Step 1 Right-click the User Information search area on the taskbar of the machine on 
which you installed UTU.

A popup menu appears.

Step 2 Select Configure.

The Campus Manager Server Configuration dialog box appears.

Step 3 Modify the settings as required.

Step 4 Click Enable SSL for communicating with an SSL enabled server. 

The port is changed to 443, which is the default port for SSL. See Figure C-2.
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Figure C-2 Enabling SSL

Step 5 Click OK to configure or Cancel to quit.

Uninstalling UTU
Before you uninstall UTU 1.1.1, you must hide the UTU desktop band. To do that, 
right-click the taskbar of the machine on which you installed UTU, and deselect 
User Search Band in the Toolbars popup menu.

To uninstall UTU:

Step 1 From the Windows taskbar, select Start > Settings > Control Panel > 
Add/Remove Programs.

The Add/Remove Programs dialog box appears.

Step 2 Select CiscoWorks User Tracking Utility.

Step 3 Click Change/Remove.

The system prompts you to confirm uninstallation.

Step 4 Click Yes.

The Remove Programs From Your Computer dialog box appears.
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Step 5 Click Yes to remove the shared DLL, UTBand.dll, and click OK.

Or

Click No. 

The uninstallation proceeds, but it does not completely uninstall UTU. To 
complete the uninstallation process:

a. Go to the directory where have you installed UTU. The default directory is 
C:\Program Files\CSCOutu.

– Enter regsvr32 /u UTBand.dll

The following message appears:

DLLUnregisterServer in UTBand.dll failed

– Click OK.

– Enter del UTBand.dll

This removes the UTU installation completely from the machine. 

Step 6 Restart your system.

Upgrading to UTU 1.1.1
You can upgrade User Tracking Utility from UTU 1.1 to UTU 1.1.1.

When you install UTU 1.1.1 above UTU 1.1, UTU prompts you to uninstall the 
previous version. A message appears:

WARNING: The setup program has detected a previous version of 
CiscoWorks User Tracking Utility. To install CiscoWorks 
User Tracking Utility 1.1.1, previous version of the product must be 
uninstalled. Do you want to uninstall CiscoWorks User Tracking Utility 
1.1.1 now?
Yes/No

Click Yes to upgrade, or No to quit.
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Reinstalling UTU
You must not install UTU 1.1.1 on a system that already has this application 
installed on it. You must check for existing installations of UTU 1.1.1 before 
attempting to reinstall it.

To check for an existing installation of UTU 1.1.1:

Step 1 Right-click on the Taskbar of the machine. 

Step 2 Select Toolbars.

If you see the User Search Band option, it means you have UTU 1.1.1 already 
installed on the system.

You must first uninstall the current installation of UTU 1.1.1, and only then 
reinstall it.
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 P P E N D I X D

Changes and Enhancements in 
Campus Manager 4.0.3

Campus Manager 4.0.3 provides management support for Layer 2 technologies. 
It is built on CiscoWorks Common Services 3.0.3 and is an integral component of 
CiscoWorks LAN Management Solution 2.5.1 (LMS 2.5.1).

In this release, the major change on the server side architecture is the refactoring 
of Campus Manager server. On the client side, the User Tracking application has 
been redesigned and now appears with a new look and feel.

This appendix contains the changes and enhancements in Campus Manager 4.0.3:

• Re-Factoring of Campus Manager Server Process, page D-12

• Improved Network Discovery, page D-12

• Improved Data Collection, page D-13

• Support for SNMPv3, page D-13

• Support for IPv6, page D-13

• Support for VLAN and VTP, page D-13

• Support for Spanning Tree Protocols, page D-14
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Re-Factoring of Campus Manager Server Process
Re-Factoring of Campus Manager Server Process
The Campus Manager server has been refactored to improve the performance and 
scalability of the application.

Before Campus Manager 4.0, the Campus Manager server process was a single 
process to perform Device Discovery, user tracking, servicing query and 
configuration from clients.

To improve the server performance and to handle larger networks, Campus 
Manager server process has been separated into transient processes for device 
discovery and User Tracking Major Acquisition.

Campus Manager 4.0.3 contains:

• Campus Manager server process as a daemon

• Transient Device Discovery process

• Transient User Tracking Major acquisition process

Campus Manager server performsData collection, query and configuration 
services.

Improved Network Discovery
With Campus Manager 4.0.3, you can:

• Provide seed devices. 

• Set the SNMP credentials.

• Run device discovery. 

Device Discovery process discovers devices and updates the Device 
Credential Repository (DCR) with the credentials of the devices.

Note Campus Manager cannot manage the devices until you run the Data 
collection process.
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Improved Data Collection
Improved Data Collection
You can choose devices to be managed by Campus Manager from the devices in 
DCR, or through data collection filters (IP subnets or VTP domains).

Support for SNMPv3
Campus Manager discovers devices configured with SNMPv3 credentials.

Support for IPv6
Campus Manager can discover IPv6, manage IPv4, and dual stack IPv6 devices. 

Support for VLAN and VTP
With Campus Manager 4.0.3, you can:

• Create a primary VLAN, secondary VLANs of different types and associate 
them to the primary VLAN, assign or move ports to secondary VLANs, and 
configure Promiscuous ports. 

• Verify the VTPv2 or VTPv3 related information for the devices in your 
network that are managed by Campus Manager. 

• Apply VTP server filter, transparent filter, or client filter for VTPv2 or 
VTPv3 domains in Topology Maps. 
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Support for Spanning Tree Protocols
Support for Spanning Tree Protocols
Campus Manager 4.0.3 provides support for Spanning Tree Protocol. Along with 
support for different types of Spanning Tree Protocol (STP)—PVST, PVST+, 
MST, MISTP, it allows you to:

• View STP parameters for each switch-cloud, VLAN or instance, or for each 
port. 

• Configure STP parameters on each port and each device.

• View and change the instance-to-VLAN mapping (for MST and MISTP).

• Configure preferred VLANs on trunk ports.

• Find the recommended optimal root for a switch cloud and highlights the 
computed Optimal Root (switch) on topology map.

• Find the recommendation for setting up the number of STP instances on a 
switch cloud. Highlights the recommended instances on the Map.

• Find the recommendation for reduction of number of STP instances.

• Highlight the instance to which the other instances can be merged.

• Map a new VLAN to recommended instance.

• Highlight the instance on the Map.

• Change certain STP parameters and view the result before applying the 
changes in the network.

Support for Configuration of Ether Channel and Inter-VLAN 
Routing

Campus Manager 4.0.3 provides the following support for EtherChannels:

• Configuring multiple links between switches as EtherChannel.

• Configuring EtherChannel load balancing parameters.
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Support for Spanning Tree Protocols
Support for Trunking
Campus Manager 4.0.3 supports the following trunking features:

• Configuring a link between two switches as a trunk.

• Configuring the allowed and disallowed VLANs on a trunk.

Support for TDR

Campus Manager 4.0.3 provides support for Cable Diagnostic Test using Time 
Domain Reflectometry (TDR).

HTML Based User Interface

Campus Manager 4.0.3 has a non-Java based user interface for User Tracking 
application and Campus Manager Administration.

Integration with Common Services 3.0.3 Components

Campus Manager 4.0.3 integrates with Common Services 3.0.3 modules like 
OGS, UII, Security and ACS, DCR, PSU, and CiscoWorks Homepage.
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Support for Spanning Tree Protocols
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